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Copyright
Copyright © 2007 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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Company Policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com

RX-44
Company Policy

Issue 1 COMPANY CONFIDENTIAL Page vii
Copyright © 2007 Nokia. All rights reserved.



Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Ni-Cd/NiMh batteries, discharge the battery from time to time by leaving the
product switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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 RX-44 product selection
The Internet Tablet offers an easy broadband access to the Internet over WLAN on a portable-size tablet.

The Internet Tablet provides users new possibilities for Internet communications. In addition to web
browsing and emailing, you can do Internet calling and Instant messaging

The product has an outstanding widescreen display that is optimal for viewing online content.

Content creation can be done by Integrated HW qwerty keyboard or by touch screen.

There are two ways of creating the Internet connection; via WLAN or via Bluetooth using a mobile phone as
a modem.

Figure 1 View of RX-44

 RX-44 transceiver features

Display and keypad features
• Color display, 16 bit (800x480, 65 536 colours), transflective with backlight

• Display brightness is adjusted automatically by ALS sensor

• Graphical user interface with selectable themes

• Keys: Qwerty keyboard, 5 way scroll key (with select), Home, Esc, Full Screen, Zoom In and Out, Power,
Keypad lock

Connectivity
• WLAN 802.11b/e/g

• Bluetooth 2.0

• HS-USB 2.0 OTG

Hardware characteristics
• Slide, BB5.0

RX-44
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• Microphone and stereo speakers

• Function keys optimized for Internet use

• Integrated webcam

• Standing mode for on-table-use

• 2GB internal memory card

• Media expansion slot compatible with microSD and miniSD

• RGB Led to indicate operation mode

User Interface
• 4.13” wide touch screen with 800x480 resolution

• Integrated HW QWERTY keyboard

SW features
Memory

• COMBO DDR 128MB

• TI OMAP 2420

• Flash 256MB

• 2GB internal memory card

Key Applications

• Mozilla based browser with Flash 9

• Internet calling with webcam

• Instant Messaging

• Email

• Media player

• RSS feed reader

Sales package, inbox
• RX-44 Internet Tablet

• Battery (BP-4L)

• Travel Charger (AC-4)

• Extra stylus input pen

• Data cable (CA-101)

• User quide

• Stereo headset HS-48

• Car holder

• Pouch, cleaning cloth

• Get started quide

• Safety, warranty and other product information booklet

Sales package, outbox
• Mobile charger (DC-4)

• Charger adapter CA-44

RX-44
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• BT headsets (mono)

• Navigation sw

• Memory cards

• miniSD card

• microSD card (with adapter)

• Stereo-headphones

• Extra stylus pack

• Stereo headphones

• FM transmitter

 Product and module list

Module name Type code Notes

Battery cover assembly

Electronic assembly 2EH Main PWB with components

Qwerty cover assembly

SWPP module

A-cover assembly

B-cover assembly

Decoration cover assembly

Front Frame assembly

Qwerty cover assembly

Slider assembly

Top key flex assembly 2FD

Main flex assembly 2FC

Display module

Camera module

 Mobile enhancements

Table 1 Batteries

Battery Type

Battery 1500mAh Li-Po BP-4L

Table 2 Chargers

Chargers Type

Fast travel charger (Euro plug), 100- 240 Vac AC-4E

Fast travel charger (US plug), 100- 240 Vac AC-4U

Travel charger (multi-voltage), Brazil/Portugal AC-12EB

RX-44
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Chargers Type

Fast travel charger (UK plug), multi-voltage AC-4X

Table 3 Car accessories

Car accessories Type

Mobile charger (EA, APAC, Americas) DC-4

 Technical specifications

RX-44 device general specifications

Unit Dimensions (L x W x T) Weight (g) Volume (cm3)

Browser 72 x 128 x 14.1 225 128

Battery endurance

Battery Capacity (mAh) Browsing time Stand-by (Always On
Enabled)

BP-4L 1500 4 hours 5 hours

Environmental conditions

Table 4 Environmental conditions

Environmental
condition

Ambient temperature Notes

Normal operation -10oC...+55oC Specifications fulfilled

Reduced performance -20oC...-10oC

+55oC...+70oC

Operational for shorts periods only

No operation or
storage

<-40oC...>+85oC No storage or operation: an attempt may damage the
phone.

Charging allowed -25oC...+50oC

Long term storage
conditions

0oC...+85oC

Table 5 Absolute maximum ratings

Signal Min Nom Max Unit Notes

Battery
voltage
(idle)

-0.3 +5.4 V Battery voltage maximum value is
specified during charging is active

RX-44
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Signal Min Nom Max Unit Notes

Battery
voltage
(active)

+5.4 V Battery voltage maximum value is
specified during charging is active

Charger
input
voltage

-0.3 +16V V

Table 6 DC characteristics

Signal Min Nom Max Unit Notes

VBAT 3.2 3.6 4.2 V 3.2V is cut off voltage

Temperature conditions
The Baseband module complies with the SPR4 Operating Conditions.

1) Operational temperature range (all specifications met within this range) –10°C...+55°C

(2) Functional temperature range (Reduced performance) -25°C... -10°C and +55°C...+70°C

(3) Storage temperature range: –40°C...+85°C

Humidity
Relative humidity range is 5...95%. The BB module is not protected against water. Condensed or splashed
water might cause malfunction. Any submerge of the phone will cause permanent damage. Long-term high
humidity, with condensation, will cause permanent damage because of corrosion.

ESD immunity
ESD limits are +-8kV for galvanic contact and +-15kV for air discharge.
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 Service tools

Product specific tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RX-44, refer to various concepts.

FS-66 Flash adapter

FS-66 has the following features:

• Provides galvanic connection to terminal test pads

• Provides standardized interface towards Control Unit

• Provides RF connection using galvanic connector or coupler
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MJ-148 Module jig

The jig includes an RF interface for WLAN and Bluetooth. In addition,
it has the following features:

• Provides mechanical interface with engine module

• Provides galvanic connection to all needed test pads in module

• Multiplexing between USB and FBUS media, controlled by Vusb:

• UI test interface

• MMC interface Audio components: IHF, MIC

• Connector for control unit

• Access for USB connector

• MJ-148 usage when whole upper block of RX-44 is connected.
Engine module and top keymat assembly (to engine module) can
be connected separately:

• MJ-148 usage when display of RX-44 is connected. Engine module,
camera module (to module jig) and top keymat assembly (to engine
module) can be connected separately:
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RJ-186 Rework jig

RJ-186 is a soldering jig used for soldering and as a rework jig for the
engine module.

SA-131 RF coupler

SA-131 is a coupler for GPS testing. It is used together with CU-4, SS-62
and FS-66.

SS-137 Domesheet
alignment jig

SS-137 is used for domesheet alignment.

General tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RX-44, refer to various concepts.

AC-33 Power supply

Universal power supply for FPS-10; included in the FPS-10 sales
package.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.
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FPS-10 Flash prommer

FPS-10 interfaces with:

• PC

• Control unit

• Flash adapter

• Smart card

FPS-10 flash prommer features:

• Flash functionality for BB5 and DCT-4 terminals

• Smart Card reader for SX-2 or SX-4

• USB traffic forwarding

• USB to FBUS/Flashbus conversion

• LAN to FBUS/Flashbus and USB conversion

• Vusb output switchable by PC command

FPS-10 sales package includes:

• FPS-10 prommer

• Power Supply with 5 country specific cords

• USB cable

Note: FPS-21 is substitute FPS-10 if FPS-10 has not been set
up.

PK-1 Software protection
key

PK-1 is a hardware protection key with a USB interface. It has the same
functionality as the PKD-1 series dongle.

PK-1 is meant for use with a PC that does not have a series interface.

To use this USB dongle for security service functions please register
the dongle in the same way as the PKD-1 series dongle.

SB-6 Bluetooth test and
interface box (sales
package)

The SB-6 test box is a generic service device used to perform Bluetooth
bit error rate (BER) testing, and establishing cordless FBUS connection
via Bluetooth. An ACP-8x charger is needed for BER testing and an
AXS-4 cable in case of cordless interface usage testing .

Sales package includes:

• SB-6 test box

• Installation and warranty information
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SB-7 WLAN test box

WLAN test requires defined position for the device.

SRT-6 Opening tool

SRT-6 is used to open phone covers.

SRT-93 Opening tool

SRT-93 is an opening tool for mobile terminal covers.

SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-10.
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SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB

SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-10 when DCT-4 phones are
flashed.

Cables
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RX-44, refer to various concepts.

CA-101 Micro USB cable

The CA-101 is a micro A/B USB cable.
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CA-31D USB cable

The CA-31D USB cable is used to connect FPS-10 or FPS-11 to a PC. It is
included in the FPS-10 and FPS-11 sales packages.

CA-35S Power cable

CA-35S is a power cable for connecting, for example, the FPS-10 flash
prommer to the Point-Of-Sales (POS) flash adapter.

CA-58RS RF tuning cable

RF tuning cable for use with a module jig.

CA-58RS RF cable extends adapter features to allow RF function tests
and RF tuning.

Features include:

• easy to use together with module jig or even stand alone

• most accurate RF connection to phone module under test

• low attenuation and small “ripple” over the width of WLAN band

Note: The RF cable must be used for RF tuning.
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DAU-9S MBUS cable

The MBUS cable DAU-9S has a modular connector and is used, for
example, between the PC's serial port and module jigs, flash adapters
or docking station adapters.

Note: Only ROHS compliant version GM 30083821 allowed.

Note: Docking station adapters valid for DCT4 products.

PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled voltage.

XCS-4 Modular cable

XCS-4 is a shielded (one specially shielded conductor) modular cable
for flashing and service purposes.
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XRS-6 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector approximately 610 mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WLAN: 0.6+-0.1dB

 Service concepts

POS (Point of Sale) flash concept

Type Description

Product specific tools

BP-4L Battery

Other tools

FLS-5 POS flash dongle

PC with Phoenix service software
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Type Description

Cables

CA-101 Micro USB cable

Flash concept with FPS-10 with PK-1

Type Description

Product specific devices

FS-66 Flash adapter

Other devices

FPS-10 Flash prommer box

PK-1 SW security device

SS-46 Interface adapter

PC with Phoenix service software

Cables

XCS-4 Modular cable

CA-35S Power cable

CA-101 Micro A/B USB cable
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CU-4 flash concept with FPS-10 and PK-1

Type Description

Product specific devices

FS-66 Flash adapter

Other devices

CU-4 Control unit

FPS-10 Flash prommer box

PK-1 SW security device

SS-62 Flash adapter base

SX-4 Smart card

PC with Phoenix service software

Cables

PCS-1 Power cable

XCS-4 Modular cable

Standard USB cable

CA-101 Micro A/B USB cable
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Module jig service concept

Figure 2 Module jig service concept

Type Description

Phone specific devices

MJ-148 Module jig

Other devices

CU-4 Control unit

FPS-10 Flash prommer box

PK-1 SW security device

SX-4 Smart card

PC with VPOS and Phoenix service software

Measurement equipment

Cables

PCS-1 DC power cable

XCS-4 Modular cable

XRF-1 RF cable

USB cable
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Type Description

GPIB control cable

Service concept for RF testing and RF/BB tuning

Figure 3 Service concept for RF testing and RF/BB tuning

Type Description

Product specific devices

MJ-148 Module jig

Other devices

CU-4 Control unit

PK-1 SW security device

SX-4 Smart card

Measurement equipment

Smart card reader

PC with Phoenix service software

Cables

DAU-9S MBUS cable

PCS-1 DC power cable
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Type Description

XRS-6 RF cable

GPIB control cable

USB cable

Bluetooth test concept with SB-6

Figure 4 Bluetooth test concept with SB-6

Type Description

Product specific tools

FS-66 Flash adapter

Other tools

CU-4 Control unit

PK-1 SW Security device

SS-62 Generic base adapter

SB-6 BT test box

ACP-8 Charger for SB-6

Cables

PCS-1 Power cable

DAU-9S Cable

PCS-1 DC power cable

Standard USB cable
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WLAN functionality testing concept with SB-7

Figure 5 WLAN functionality testing concept with SB-7

Type Description

Product specific tools

FS-66 Flash adapter

Other tools

CU-4 Control unit

PCS-1 DC power cable

PK-1 SW Security device

SS-62 Generic base adapter

Cables

PCS-1 Power cable

DAU-9S Cable

Standard USB cable
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 Phoenix installation steps in brief
Phoenix is the service software for reprogramming, testing and tuning the phone.

Recommended PC HW requirements:

• Computer Processor: Pentium 700 MHz or higher

• RAM 256 MB

• Disk space 100-200 MB

Supported operating systems:

• Windows 2000 Service Pack 3 or higher

• Windows XP Service Pack 1 or higher

To install Phoenix, you need to:

• Connect a PK-1 dongle,

• Install the Phoenix Service SW,

• Install the Data Package for Phoenix,

• Configure users,

• Manage connection settings (depends on the tools you are using).

Note: If you use FPS-10:

• Update FPS-10 SW,

• Activate SX-4 Smart Card if you need tuning and testing functions in service software.

Note: When FPS-10 is used only for product SW updates, SX-4 Smart card is not needed.

Phoenix is now ready to be used with FPS-10 flash prommer and other tools as well.

The Phoenix Service Software installation contains:

• Service software support for all phone models included in the package

• Flash update package files for programming devices

• All needed drivers for:

• PK-1 dongle

• CA-101 USB cable

Note: Separate installation packages for flash update files and drivers are also available, but it is
not necessary to use them unless updates appear between Phoenix Service SW releases. If separate
update packages are used, they should be used after Phoenix and data packages have been installed.

The product model specific data package includes all changing product -specific data:

• Product software binary files

• Files for type label printing

• Validation file for the Faultlog repair data reporting system

• All product specific configuration files for Phoenix software components

Note: Phoenix Service SW and product data packages should only be used as complete installation
packages. Uninstallation should be made from the Windows Control Panel.

 Installing Phoenix

Prerequisites
• Check that a dongle is attached to the parallel port of your computer.
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• Download the installation package (for example, phoenix_service_sw_2007_34.exe ) to your computer (in
C:\TEMP, for instance).

• Close all other programs.

• Run the application file (for example, phoenix_service_sw_2007_34.exe) and follow the instructions on the
screen.

• Administrator rights may be required to be able to install Phoenix depending on the operating system.

• If uninstalling or rebooting is needed at any point, you will be prompted by the Install Shield program.

Context
If at any point during installation you get the following message, the dongle is not found and installation
cannot continue:

Figure 6 Dongle not found

One possible reason may be a defective or too old PK-1 Dongle (five digit serial number Dongle when used
with FPS-10 prommers).

Check the parallel port used for PK-1. After correcting the problem, restart installation application.

For more detailed information, please refer to Phoenix Help files. Each feature in Phoenix has its own Help
function, which can be activated while running the program. Press the F1 key or the feature’s Help button
to activate a Help file.

Steps
1. To start installation, run phoenix_service_sw_2007_34.exe .

2. In the Welcome dialogue, click Next.
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3. Read the disclaimer carefully.

4. Choose destination folder.

The default folder C:\ProgramFiles\Nokia\Phoenix is recommended.

5. To continue, click Next .

You may choose another location by selecting Browse (not recommended).

6. Wait for the components to be copied.

Progress of the setup is shown in the Setup Status window.

7. Wait for the drivers to be installed and updated.

The process may take several minutes to complete.

If the operating system does not require rebooting, the PC components are registered right away.

If the operating system used requires restarting your computer, the Install Shield Wizard will tell you
about it. Select Yes... to reboot the PC immediately and No... to reboot the PC manually afterwards.

After the reboot, components are registered and Phoenix is ready for use.

Note: Phoenix does not work, if components have not been registered.
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8. To end installation, click Finish .

Phoenix is now ready for use.

Next actions
After the installation, Phoenix service software can be used after:
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• installing phone model specific data package for Phoenix

• configuring users and connections

FPS-10 flash prommers can be used after updating their Flash Update Package files.

 Updating Phoenix installation
If you already have the Phoenix Service SW installed on your computer, sooner or later there will be need to
update it when new versions are released.

Always use the latest available versions of both the Phoenix Service SW and the product specific data package.
Instructions can be found in product model specific Technical Bulletins and data package readme.txt files
(shown during installation).

To update the Phoenix you need to take exactly the same steps as when installing it for the first time:

• Download the installation package to your computer hard disk.

• Close all other programs.

• Run the application file (for example, phoenix_service_sw_2007_34.exe).

• New version of Phoenix will be installed.

• Driver versions will be checked and updated. When you update the Phoenix from old to new version (for
example, a14_2004_16_4_47 to a15_2004_24_7_55), the update will take place automatically without
uninstallation.

If you try to update the Phoenix with the same version that you already have (for example, a15_2004_24_7_55
to a15_2004_24_7_55) you are asked if you want to uninstall the version of Phoenix you have on your PC. In
this case you can choose between total uninstallation and repair just like when you choose to uninstall
Phoenix service software from the Windows Control panel.

If you try to install an older version (for example, downgrade from a15_2004_24_7_55 to a14_2004_16_4_47),
installation will be interrupted.

Figure 7 Installation interrupted

Always follow the instructions on the screen.

 Uninstalling Phoenix

Context
You can uninstall Phoenix service software manually from the Windows Control Panel - Add/Remove
Programs.

Steps
1. Start Control Panel -> Add/Remove Programs.

2. Select Phoenix Service Software from the list and press Remove button to uninstall Phoenix.
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3. Select Yes to start the uninstallation and No to cancel the uninstallation of Phoenix.

4. Wait until the uninstallation has completed.

If the operating system used requires rebooting, Install Shield Wizard will tell you about it. Select Yes to
reboot the PC immediately and No to reboot the PC manually afterwards.

 Repairing Phoenix installation

Context
If you experience any problems with service software or suspect that files have been corrupted, uninstall
Phoenix first and then reinstall it again.

Steps
1. Reinstall Phoenix like described in the section Installing Phoenix.

 Product data package overview
Each product has its own data package (DP). The product data package contains all product-specific data files
to make the Phoenix service software and tools usable with a certain product model.

The product data package contains the following:

• Product software binary files

• Files for type label printing

• Validation file for the fault log repair data reporting system

• All product-specific configuration files for Phoenix software components

Data files are stored in C:\Program Files\Nokia\Phoenix (default).

If you change the default directory, check from the Phoenix menu Tools->Options->Product Location that the
directory is configured correctly.

 Installing Phoenix data package

Prerequisites
• Product data package contains all product-specific data to make the Phoenix Service Software and tools

usable with a certain phone model.

• Check that the dongle is attached to the parallel port of your computer.

• Install Phoenix Service SW.

RX-44
Service Software Instructions

Page 3 –10 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



• Download the installation package (for example, Nokia_firmware_RX-44_v1_0_0200735-11.exe) to your
computer (for example, in C:\TEMP).

• Close all other programs.

• Run the application file (for example, Nokia_firmware_RX-44_v1_0_0200735-11.exe) and follow the
instructions on the screen.

If you already have the Phoenix Service SW installed on your computer, you will need to update it when a
new version is released.

Note: Very often the Phoenix Service SW and the phone-specific data package for Phoenix come in
pairs, meaning that a certain version of Phoenix can only be used with a certain version of the data
package. Always use the latest available versions of both. Instructions can be found in phone model
specific Technical Bulletins and readme.txt files of the data packages.

Steps
1. To start installation, run the application file (for example, Nokia_firmware_RX-44_v1_0_0200735-11.exe).

2. Click Next, and wait for the installation files to be extracted.

3. To continue, click Next .

In this view you can see the contents of the data package. Read the text carefully. There should be
information about the Phoenix version required with this data package.
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4. To continue, click Next .

5. Confirm location and click Next to continue.

The install shield checks where the Phoenix application is installed and the directory is shown.
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6. To start copying the files, click Next .

Product-specific files will be installed. Please wait.

7. To complete the installation, click Finish .

You now have all phone model specific files installed in your Phoenix Service SW.
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Next actions
After installing product-specific datapackage, you can use Phoenix for flashing products and printing type
labels.

If you have an old Phoenix version on your PC, you need to update FPS-10 by running separate flash update
package. If you have installed the latest Phoenix version, it updates the files needed for flashing
automatically.

 Uninstalling Phoenix data package

Context
If you try to install the same version of Phoenix data package that you already have, you are asked if you
want to uninstall the version you have on your PC. Older versions of data packages don´t need to be
uninstalled unless instructions to do so are given in the readme.txtfile of the data package and bulletins
concerning the release.

Please read all related documents carefully.

Steps
1. To start uninstallation, run the same application file (for example,

Nokia_firmware_RX-44_v1_0_0200735-11.exe)

2. Select Remove button to uninstall all datapackage features, click Next.

3. Click Yes to uninstall, No if you don’t want to uninstall.
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4. Once the previously installed data package is uninstalled, click Finish.

Alternative steps
• You can also uninstall the data package manually from

Windows Control Panel→Add/Remove Programs→Nokia_firmware_ xx-xx*_v1_0_0200735-11  (*=
type designator of the product).

Next actions
Reinstall the datapackage by running the product-specific application file.

 Configuring users in Phoenix

Steps
1. Start Phoenix service software, and log in.

Figure 8 Phoenix login

If the user ID is already configured, select s/he from the User name drop-down list, and click OK.

2. To add a new user, or to edit existing ones, click Maintain.
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3. To add a new user, click New.

4. Type in the name and initials of the user, and click OK.

A new user is now created.

5. Click OK. You are now able to login with this user name.

6. Click OK.

Figure 9 New user configured

 Managing connections in Phoenix

Steps
1. Connect the service tools to your PC and attach the product to the service jig.

2. Start Phoenix Service SW and log in.

3. Choose File -> Manage Connections.

Figure 10 Phoenix icon

Existing connections can be selected, edited, deleted, and new ones created by using this dialog.
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4. Click New to add a new connection. Pressing New starts the Connection Wizard. You can also create
a connection manually with the Connection Wizard (see step 3).

The wizard will automatically try to configure the connection. Please note that this may take a
considerable amount of time because Phoenix will go through all connections on the PC.

5. Select Nokia flash programming device, if you want to create a connection for prommer. Select JBL-9 /
Generic FBUS, if you need a connection for DAU-9S cable.
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6. Press Next button. Phoenix starts to scan devices.

7. Phoenix shows what connections can be made after scanning. Press Next button.

8. Choose Nokia Flash Programming Device you are using from the list. Select NFPD USB (FBUS), if the
prommer is connected to your PC via USB cable. Select NFPD TCP (serial number), if the prommer is
connected to your PC via TCP / IP. Check the serial number from the prommer’s label.

9. Click Finish to complete the configuration of the connection.

10. Press Manual Setup button, if you want to create a connection manually.

11. Enter IP address and serial number of the prommer to the parameters, if you want to use NFPD TCP
connection.
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12. Enter the serial number of the prommer and select FBUS as the active media to the parameters, if you
want to use NFPD USB (FBUS) connection.

13. Enter the serial port number to the parameters, if you want to use FBUS serial connection.

14. Activate the connection you want to use by clicking it, use up/down arrows to move it on top of the list,
and click Apply.

The connection is now selected and can be used after closing the Manage Connections window. Selected
connection will be shown on the right hand bottom corner of the screen.
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15. To use the selected connection, connect the phone to Phoenix with correct service tools, make sure that
it is switched on and select Scan Product.

When a product is found, Phoenix will load product support. Name of the loaded product support module
and its version information will be shown on the bottom of the screen.

 Installing flash support files for FPS-10

Prerequisites
Note: You need to install flash support files for FPS-10 only, if you don’t have the latest Phoenix
available or the flash support files have changed after the latest Phoenix release.

• Flash support files are installed automatically, when you install Phoenix. Use Phoenix packages later than
September 2007.

• Normally it is enough to install Phoenix and the phone-specific data package because the Phoenix
installation always includes the latest flash update package files for FPS-10.

• A separate installation package for flash support files is available, and the files can be updated according
to this instruction, if updates appear between new Phoenix / data package releases

Context
If you are NOT using a separate flash update package, you can skip this section and continue with updating
FPS-10 flash prommer software after installing a new phone data package.
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Steps
1. To begin installation, double- click flash update execution file e.g. FlashUpdate_xx_yy_zzz.msi .

RX-44
Service Software Instructions

Issue 1 COMPANY CONFIDENTIAL Page 3 –21
Copyright © 2007 Nokia. All rights reserved.



2. To continue, click Next. The installation application installs the new flash files to the default destination
folder C:\Program Files\Common Files\Nokia\Tss\Flash. Don’t move or copy these files to another
directory, because that makes updating the prommer sw difficult.

3. To continue installation, click Install. To exit the installation wizard, click Cancel.

4. You can see the progress of the installation. Wait, until the installation completes.
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5. Click Finish to end the installation.

6. If the same version of Flash Update package already exists on PC, and you try to reinstall it, the installation
application asks, whether you want to modify, repair or remove it. Select Remove and click Next.
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7. To confirm that you really want to remove the older flash update, click Remove.

8. To end the uninstallation of flash update, click Finish.

9. If you want to downgrade the existing flash update version to older one, uninstall newer flash update
files manually from Control Panel -> Add/Remove Programs -> Nokia Flash Update and then rerun
the installation application again.
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Next actions
Update FPS-10 flash prommers using Phoenix.

 Updating FPS-10 flash prommer software

Steps
1. Start Phoenix Service Software and log in, select a connection to the prommer.

2. Choose Flashing -> Prommer Maintenance.

3. When the new flash update package is installed to the computer you will be asked to update the files
to your Prommer. Click Yes. Click OK, if the computer informs you about unsafe removal of the device.

4. Alternatively you can update FPS-10 flash prommer software by clicking Update button.

5. Wait until you are notified that update has been successful. The procedure will take a couple of minutes.
Click OK to close the Update Done window.

Figure 11 Prommer SW update finished

6. If you are using FPS-10 flash prommer, check that it is detected from the progress info. Check also the
status leds in the FPS-10. The MODE2 led (green), VBAT and POWER leds (red) should be lit. If you are
using LAN connection, the LAN led (yellow) should be blinking.

7. Check that your FPS-10 flash prommer has enough memory. Flashing RX-44 with the FPS-10 needs more
than 128 MB memory in the prommer. You need to install a separate memory card (standard compact
flash at least 256 MB and standard PCMCIA Compact Flash adapter) to the FPS-10 external PC Card slot.
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You can also install a memory card to internal compact flash slot inside FPS-10. See instructions in the
FPS-10 User Guide. If you use internal compact flash, then you don’t need PCMCIA Compact Flash adapter.
Compact Flash is also available as service device spare part code 0780232, type MEMORY CARD CF 2G FOR
FPS-10.

8. A memory card has to be formatted before use. Press FPS10 Conf button in Prommer Maintenance dialog.

9. Check PCCard Compact Flash checkbox in Media Formatting and press OK.

10. After successful formatting, Phoenix will inform “Media preparation finished 100%”. If the formatting
is not successful, check that the PC Card is properly installed, reboot the FPS-10 and reformat it.
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Alternative steps
• You can update FPS-10 SW by clicking the Update button and selecting the appropriate fpsxupd.ini file in

C:\Program Files\Nokia\Phoenix\Flash.

Figure 12 Flash directory window

• All files can be loaded separately to the prommer used. To do this, click the right mouse button in the
Flash box files window and select the file type to be loaded.

More information can be found in Phoenix Help.

 Flashing with FPS-10 Flash Prommer

Steps
1. First make flashing setup like described in the FS-66 / SS-46 flash concept or in the FS-66 / SS-62 / CU-4

flash concept. Remember to connect the CA-101 cable from the FPS-10 front panel to the product

2. Start Phoenix Service Software. Log in and manage connection for the FPS-10. Create and select USB
Connection or TCP / IP connection depending on the flashing setup.

3. Check that FPS-10 is detected. Check also the status leds in the FPS-10. The MODE2 led (green), VBAT and
POWER leds (red) should be lit. If you are using TCP/IP connection, the LAN led (yellow) should be blinking.

4. Choose Flashing ->Firmware update.
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5. The Firmware Update dialog reads product code and sets flash filename to a default name, if you have
installed datapackage. Press Options button and browse another file to be flashed, if you want.

NOTE!

The SW update erases all data in the device memory.

Data on a internal or external memory card will not be erased.

Phoenix service SW cannot be used to backup/restore user data or format user data on internal or external
memory.

To make backup/restore or format fuctions, applications need to be started from device.

Backup and restore function

If data should be saved, data should be backupped with the backup/restore utility in the device.

To backup/restore user data, select Settings > Backup/restore -> New backup.

In New backup, change the name of the backup and define the desired location of the backup. In Select
data for backup, select data types you want to back up.

Note that the following information, for example, is not backed up:

• contents of the non-removable internal memory card on Nokia N810 Internet Tablet

• theme settings, when you restore backups from previous product versions
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• Bluetooth connectivity settings

• browser settings

• installed applications

To restore data, do the following:

a Select the desired backup and restore

b In Select data for backup, select data types to restore

Format internal or external memory card

Data from internal and external memory card can be cleared with the Format utility of the device.

To view and manage the contents of a memory card, select Utilities > File manager and the desired
memory card from the folder list.

To format a memory card in file manager, push the menu button (or menu icon in the upper left corner
of the display).

Select Tools > Format memory card.

All data is permanently deleted.

Clear device – make refurbishment

To clear the device select Applications > Settings > Control panel. Push menu button (or menu icon in
the upper left corner of the display). Select Tools > Clear device > > enter the lock code of the device,
and tap OK to clear the data. Default lock code is 12345.

All content of device and internal 2 GB memory will be deleted. All applications will be closed and the
device will restart. Push ok to start.

6. Press Start to flash the product. Wait until you are notified that flashing has been successful. The procedure
will take a couple of minutes. If the connection is NFPD USB (FBUS), then the USB led (green) should be
blinking during flashing. If the connection is NFPD TCP, then the LAN led (yellow) should be blinking. The
MODE2 is blinking, when the file is loaded to the FPS-10 flash prommer. See the flash progress also from
the Firmware Update dialog.

7. After flashing successfully, click the Close button to close the Firmware Update dialog.
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 Main troubleshooting

Context
This section is intended to be a guide for localising and repairing electrical faults. The fault repairing is divided
into troubleshooting paths.

The following main troubleshooting tree describes the different baseband troubleshooting paths to be
followed in fault situations.
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Troubleshooting flow
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 Dead or jammed device troubleshooting

Troubleshooting flow
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 Power key troubleshooting

Troubleshooting flow
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 General power checking troubleshooting

Troubleshooting flow
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 Battery current measuring troubleshooting

Troubleshooting flow
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 Flash programming fault troubleshooting

Troubleshooting flow
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 Clocking troubleshooting

Troubleshooting flow
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 APE CPU troubleshooting

Troubleshooting flow
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 Charging troubleshooting

Troubleshooting flow
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 HW keys troubleshooting

Troubleshooting flow
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 SDRAM temperature sensor troubleshooting

Troubleshooting flow
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 Memory troubleshooting

Troubleshooting flow
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 Memorycards troubleshooting

Troubleshooting flow
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 USB interface troubleshooting

Troubleshooting flow
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Figure 13 Full speed USB

Figure 14 High speed USB differential pulse

 GPS troubleshooting

GPS antenna
The GPS antenna is located at the top of the left corner of B-cover.
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Figure 15 GPS antenna

The GPS antenna is mounted into B-cover and antenna contact point towards antenna test pad on PWB is
pointed out in a GPS antenna picture.

Figure 16 GPS key components

Components are located on the bottom side of the PWB at the upper left corner.
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GPS layout and basic test points

Figure 17 GPS layout and basic test points

VBat, ASIC internal LDO voltages, and clocks are available as shown in figure above.

GPS settings for Phoenix

GPS control

Context
Use the following to test GPS using Phoenix.

Steps
1. Start Phoenix service software.

2. From the File menu, select Scan Product and check that the correct product version is displayed.
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3. From the Testing menu, select GPS Control. This opens up GPS Control dialogue box, as shown in the
figure below, and enables the GPS.

Figure 18 GPS Control dialog box

At this point all clocks should be present, GPS_En_Reset & SleepX should be high, and Vdd_Dig, Vcc_TCXO &
Vcc_PLL/VCO will be present.

Receiver On turns on all RF sections of the ASIC and so all LDOs will be on. These checks are part of GPS
basic checks troubleshooting (page 4–30).

Quick Test window
The Quick Test window has all the necessary functionality for GPS troubleshooting. Ensure the test setup is
correct and click Start Test. (Select Help for further information).

This test will perform 3 tests in one; Self Test, Oscillator Test (not supported) and CW Test, and will provide
a Pass/Fail response. It also contains a Receiver On button. These checks are part of GPS failure
troubleshooting (page 4–29).
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Figure 19 GPS Quick Test window for GPS troubleshooting

GPS RF test points
The GPS antenna test pad is located on the left side under the decoration cover as shown in figure "GPS
antenna test pad". Checking for a connection of test point will confirm that the antenna is working correctly,
as well as performing a radiated CW test.

J 6201 = GPS Antenna test pad

In order to probe GPS RF test points, inject 1575.52 MHz tone @ -50dBm at the GPS antenna test connector
and select Receiver On, then probe the GPS RF test points as shown in figure "GPS RF probe points". Compare
RF levels with a known reference phone.
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Figure 20 GPS antenna test pads

Figure 21 GPS RF probe points
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GPS failure troubleshooting

Context
GPS troubleshooting is broken down into two parts: general GPS failure & GPS basic checks. The GPS failure
troubleshooting flow can be followed and, where applicable, will feed into the Basic checks troubleshooting
flow.

Troubleshooting flow
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GPS basic checks troubleshooting flow

Troubleshooting flow
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GPS radiated CW test
The meaning of the test is to confirm that GPS antenna is working properly and antenna connection to the
test pad is good enough.

The coupler position A4 in SA-131:

Figure 22 Test set-up

Coupler attenuation is about 20 dB at GPS frequency.

GPS settings for Phoenix; GPS control

Context
Use the following to test GPS using Phoenix.

Steps
1. Start Phoenix service software.

2. From the File menu, select Scan Product and check that the correct product version is displayed.

3. From the Testing menu, select GPS Control. This opens up GPS Control dialogue box, as shown in the figure
below, and enables the GPS.
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4. Choose Test state to Radiated.

5. Attach the SA-131 adapter to CU4/SS-62 +FS-66 as shown in figure above (Test Set-Up).

6. Adjust signal level and frequency from RF generator according to instructions which could be found by
clicking “Help” button.

7. Click Start Test.

This test will perform 3 tests in one; Self Test, Oscillator Test (not supported) and CW Test, and will provide
a Pass/Fail response.

 Display module troubleshooting

General instructions for display troubleshooting
The first step is to verify with a working display that the fault is not on the display module itself. The display
module cannot be repaired.

The second step is to check that the engine is working normally. This can be done by connecting the phone
to a docking station and starting Phoenix service software. With the help of Phoenix read the phone
information to check that also the application engine is functioning normally (you should be able to read the
APE ID).

After these checks proceed to the display troubleshooting flowcharts. Use the Display Test tool in Phoenix to
find the detailed fault mode.

Pixel defects

Table 7 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.
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Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing. If a part of the image is
missing, change the display module. If the image is
otherwise corrupted, follow the appropriate
troubleshooting diagram.

Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the
connector or in the backlight power source in the
main engine of the phone. Backlight is also
controlled automatically by the ambient light
sensor.

This means that in case the display is working
(image OK), the backlight is faulty.

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.

Table 8 Pixel defects

Bright sub-pixels (sometimes called on-pixels or stuck-on) are
characterized by the appearance of bright/colored
pixels in, for example, black full screen picture.

Dark sub-pixels (sometimes called off-pixels, stuck-off, or black
pixels) are characterized by the appearance of dark
pixels in white, red, green, or blue full-screen
picture.

Combined sub-pixel defects are characterized by at least two sub-pixels
defects (bright or dim) being closer than 5 mm to
each other.

Temporal sub-pixels (sometimes called blinking defects) exhibit
temporal variations not related to any steady-state
video input. Temporal sub-pixel defects may be
intermittent, exhibit a sudden change of state, or
be flickering.

Table 9 Defects table

Item Bright dot (sub-
pixel) defect

Dark dot (sub-
pixel) defect

Total

1 Defect counts 2 0 2

2 Combined sub-
pixel defect

Not allowed
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Item Bright dot (sub-
pixel) defect

Dark dot (sub-
pixel) defect

Total

3 Temporal sub-
pixel defect

Not allowed

Note: Blinking pixels are not allowed in normal operating temperatures and light conditions.
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Display troubleshooting

Troubleshooting flow
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Touch panel troubleshooting

Troubleshooting flow
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Display LED troubleshooting

Troubleshooting flow
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Ambient Light Sensor

Ambient Light Sensor

Ambient Light Sensor consists of the following components:

• Light guide (in A-Cover assembly)

• Ambient Light Sensor (ALS) is located in 2FC Main Flex assembly.

ALS is a digital I2C interface component, having two channels with different spectral sensitivities. When
combined, the component responds to illuminance similar as human eye.

• Vdd Filtering capacitor C1000.

Ambient Light Sensor information is used to control keypad and display brightness of the device.

Keyboard backlight is turned OFF, when it’s not needed. Display brightness is dimmed, when environment
lighting is dark.

Ambient Light Sensor is calibrated in production and can be re-tuned in service points though not
recommended unless calibration coefficient are lost for some reason

ALS troubleshooting

Context
Functionality check:

Steps
1. Connect phone to Phoenix and set the phone (e.g. on the table) so that the amount of ambient light seen

by ALS is as stable as possible.

2. Start Phoenix

3. Choose File -> Scan product

4. Choose Testing -> Display Test

5. Open the Lights tab, check Ambient Light Sensor check box, click Read, cover the sensor and click Read
again. When covered, Luminance reading should be less than after clicking Read without covering the
sensor.
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6. If component doesn’t give any reading or reading doesn’t change when sensor is/is not covered, replace
the part.

Note: After replacing the ALS. If calibration values of the new sensor are lost or for some other
reason, ALS re-tuning is required (see instructions later in this document).

When doing the ALS calibration procedure, it is required to have a reference phone, which includes
calibrated ALS. ALS re-tuning instructions show why the reference phone is needed.

Retuning ALS

Steps
1. Connect reference phone to Phoenix and set the phone (e.g. on the table) so that the amount of ambient

light seen by ALS is as stabile as possible.

2. Start Phoenix.

3. Choose File→Scan Product.
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4. Choose Tuning -> Ambient Light Sensor Calibration. You should see the following window

5. Read AD-count values for Channel 0 and Channel 1 by click Read button and write them down.

6. Repeat 1-5 for the phone to be calibrated and make sure the phone to be calibrated is located in the
same place as reference phone was when luminance reading was taken.

7. Calculate co-efficient from reference phone and phone to be calibrated AD-count values by division: Co-
efficient = AD-count(reference phone) / AD-count(phone to be calibrated), write down the calculated co-
efficient values.

8. -> Iterate by changing Channel 0 and Channel 1 (reference level) values (remove cross from ‘Use default
values only’). After writing some value to Channel 0 and Channel 1 (reference value), calibrate button
must be pressed. Stop iterating when Co-efficient is equal to Co-efficient calculated in bullet 7. Note that
decimal numbers should be used in the iteration in order to achieve enough precision (e.g. 200.2455)

9. After having same Co-efficient value in “Co-efficient” textbox as the calculated value, make sure that
ambient light values (read using Testing → Display Test → “Luminance” textbox) are almost the same
in reference phone and calibrated phone. Remember that illuminance readings for reference and
calibrated phones must be done in the same ambient light conditions. If illuminance values differs a lot
(difference max. +- 10%), repeat whole ALS re-tuning procedure.

10. To end the calibration, click Close.
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RGB LED driver troubleshooting

Troubleshooting flow
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 Bluetooth troubleshooting

Introduction to Bluetooth troubleshooting
Bluetooth problems that can occur:

Problem Description

A malfunction in the BT ASIC, BB ASICs or Phone’s BT
SMD components.

This is unpredictable and could have many causes
i.e. SW or HW related.

The main issue is to find out if the problem is related to the BT antenna or related to the BT system or the
phone’s BB and then replace/fix the faulty component.

Bluetooth/WLAN antenna element
Bluetooth and WLAN have common antenna element which is mounted into decoration cover. Antenna
connection to PWB antenna pad is made through pogo pin.

Figure 23 BT/WLAN antenna
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Figure 24 BT/WLAN antenna pad

Bluetooth component layout

Bluetooth settings for Phoenix

Steps
1. Start Phoenix service software.

2. From the File menu, choose Open Product, and then choose the correct type designator from the
Product list.

3. Place the phone to a flash adapter in the local mode.
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4. Choose Testing→Bluetooth LOCALS .

5. Locate SB-6's serial number (12 digits) found in the type label on the back of SB-6.

In addition to SB-6, JBT-3, JBT-6 and JBT-9 Bluetooth test boxes can be used.

6. In the Bluetooth LOCALS window, write the 12-digit serial number on the
Counterpart BT Device Address line.

This needs to be done only once provided that SB-6 is not changed.

7. Place the SB-6 box near (within 10 cm) the BT antenna and click Run BER Test.

Results
Bit Error Rate test result is displayed in the Bit Error Rate (BER) Tests pane in the Bluetooth LOCALS window.

Figure 25 BER test result

Bluetooth self tests in Phoenix

Steps
1. Start Phoenix service software.

2. From the File menu, choose Open Product, and then choose the correct type designator from the
Product list.

3. Connect the phone to a docking station in the local mode.

4. Choose Testing→Self Tests .

5. Choose the following Bluetooth related tests:

• Bluetooth

6. To run the tests, click Start.
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Figure 26 Bluetooth self tests in Phoenix
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Bluetooth BER failure troubleshooting 1 and 2

Troubleshooting flow
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 Audio troubleshooting

Audio troubleshooting test instructions
Headphone outputs are single-ended type thus those must be measured against ground.

Internal loudspeakers outputs are measured using a current probe, if a special low-pass filter designed for
measuring digital amplifiers is not available.

Required equipment
The following equipment is needed for the tests:

• Oscilloscope

• Current probe (Internal handsfree DPMA output measurement)

• Low-pass filter designed for DPMA measurements

• Phoenix service software

• Battery voltage 3.7V

• Nokia HS-48 headset

• Sine signal generator

• Multimeter

Test procedure
Audios can be tested using the Phoenix audio routing options. Two different audio loop paths can be
activated:

• From internal microphone to headphone output (HP microphone in Ext earpiece out)

• From external microphone to headphone output (Ext microphone in Ext earpiece out)

These loops are basically meant for device’s internal microphone and headset’s microphone testing.

For internal loudspeakers and headphone output testing there is possibility to use test signals generated
inside of the device.

Note: Sine test signals frequency and amplitude are fixed.

It’s possible to route the signal to the following outputs:

• Headphone left channel (Generated earpiece left out)

• Headphone right channel (Generated earpiece right out)

• Internal loudspeaker (Generated int handsfree out)

Each audio output configuration sets the internal test signal generator or microphone routing to the specified
output. Test signal path gains are fixed and they cannot be changed using Phoenix. Microphone is tested by
talking to the microphone and listening the output signal using headphones/headsets.

Correct measurement/test points for each test case are presented in a table below.

Phoenix audio loop tests and test results
The results presented in a table apply when no accessory is connected and the battery voltage is set to 3.7V.

Internal loudspeakers are in place during the measurements. Applying a headset or a headphone during
measurement causes a significant drop in measured quantities.

Output device Output terminals Output voltage (mVrms)

Headphone left X4100 pin 5 and gnd ~43mVrms
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Output device Output terminals Output voltage (mVrms)

Headphone right X4100 pin 4 and gnd ~43mVrms

Speaker left L4103 and L4104 pads ~300mVrms

Speaker right L4101 and L4102 pads ~300mVrms

Internal microphone can be tested by subjective testing. When using internal mic to headphone out loop
connect known working headset (Nokia HS-48) to the device and test if you can hear the sound through the
headsets.

External microphone is tested by feeding test signal to the X4100’s pin 3 and gnd.

In this case use input signal presented a table below and check also supposed output.

Fastest and easiest way to test external microphone functionality is to insert known working (HS-48) headset
to the audio connector, enable Ext microphone in Ext earpiece out test audio loop by the Phoenix and just
speak and listen.

Note: Before testing any microphone path test the headphone output functionality as described on
previous page.

Input terminals Output terminals Input signal Output signa

X4100 pin 3 and gnd X4100 pin 5 and gnd or X4100
pin 4 and gnd

Sine 1kHz/10mVrms Sine 1kHz/
~65mVrms (without
load)
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Accessory troubleshooting

Troubleshooting flow
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Headset/headphone earpiece troubleshooting

Troubleshooting flow
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Headset microphone troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow
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Internal speakers troubleshooting

Troubleshooting flow
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 Baseband manual tuning guide

Energy management calibration

Prerequisites
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.

• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose File→ Scan Product.

4. Choose Tuning→Energy Management Calibration.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 10 Calibration value limits

Parameter Min. Max.

ADC Gain 13000 13350

ADC Offset -14 14

BSI Gain 1100 1300

VBAT Gain 21000 21900

VBAT Offset 2450 2570

IBAT Gain 7750 12250

9. Click Read, and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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 RF troubleshooting and tuning

WLAN RF troubleshooting

Introduction to WLAN RF troubleshooting
Measurements should be done using Spectrum analyzer with high-frequency high impedance passive probe
(LO-/reference frequencies and RF power levels) and Oscilloscope with a 10:1 probe (DC-voltages and low
frequency signals).

The RF-section is build around one RF-ASIC (STLC4560 N6300). For easier troubleshooting, this RF
troubleshooting document is divided in to sections.

Before changing STLC4560, please check following things: Supply voltages are OK and serial communication
coming from baseband to STLC4560.

Note: Most RF semiconductors are static discharge sensitive!

So ESD protection must be taken care of during repair (ground straps and ESD soldering irons).

STLC4560 and FEM are moisture sensitive so parts must be pre-baked prior to soldering.

Apart from key components described in this document here are a lot of discrete components (resistors,
inductors and capacitors) which troubleshooting is done by checking if soldering of the component is done
properly (for factory repairs checking if it is missing from PWB).

Capacitor can be checked for shortening and resistors for value by means of an ohmmeter, but be aware in-
circuit measurements should be evaluated carefully.

Note: Please be aware that all measured voltages or RF levels in this document are rough figures.
Especially RF levels varies due to different measuring equipment or different grounding of the used
probe. When using RF probe usually a good way is to use metallic tweezers to connect probe ground
to PWB ground as close to measurement point as possible.

Figure 27 WLAN, Bluetooth and GPS placement
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Figure 28 RF key component placement

Figure 29 WLAN RF measurement points
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General instructions for TX troubleshooting

Context
To start TX troubleshooting

Steps
1. Connect the module jig MJ-148 to a computer with a DAU-9S cable or to an FPS-10 flash prommer with an

XCS-4 modular cable and USB cable. Make sure that you have a PK-1 dongle connected to the computer’s
parallel port.

2. Connect a DC power supply to the module test jig with an FLC-2 cable.

Note: If CU-4 is used then correct DC supply voltage is 12V . If DC power is connected directly to
module test jig then absolutely max. DC power is 4.2 V.Use nominal value 3.7 V.

3. Connect an RF cable to the RF connector of the PWB board and measurement equipment; or at least a
10dB attenuator, otherwise the PA may be damaged. Use a spectrum analyzer as measurement
equipment.

Note: The maximum input power of a spectrum analyzer is +30dBm. It is recommended to use 10dB
attenuator on the spectrum analyzer input to prevent any damage.

4. Set the phone module to test jig and start Phoenix service software.

5. Initialize connection to the phone. (Use FBUS driver when using DAU-9S.

6. To choose a product in Phoenix: From the File menu, choose “Choose Product” and select RX-44 from the
list or from the File menu, choose “Scan Product”.

7. From the toolbar, set operating mode to "Local".

8. From the Testing menu, choose “WLAN TX tests”.

9. In the “WLAN TX tests” window:

• Test mode "Continuous TX"

• Data rate "11 MBit/s (Clk)"

• Channel 7 (2.442 GHz)

• Power loop "Calibrated"

• All other items use "defaults"

• Press "Start" button"

• Power level(dBm) "17"

• Press "Set" button

Table 11 Maximum wlan TX power limits for US version

Data rate Max. Wlan TX power for US version [dBm]

Channel

1 2-10 11

1, 2, 5.5 and 11 Mbit/s 17 17 17

6 and 9 Mbit/s 14 15 15

12 and 18 Mbit/s 14 15 15

24 and 36 Mbit/s 13 13 13

48 and 54 Mbit/s 13 13 13
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Table 12 Maximum wlan TX power limits for EU version

Data rate Max. Wlan TX power for EU version [dBm]

Channel

1 2-12 13

1, 2, 5.5 and 11 Mbit/s 17 17 17

6 and 9 Mbit/s 14 15 15

12 and 18 Mbit/s 14 15 15

24 and 36 Mbit/s 13 13 13

48 and 54 Mbit/s 13 13 13
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WLAN TX and STLC4560 troubleshooting

Figure 30 WLAN TX troubleshooting
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Figure 31 WLAN STLC4560 troubleshooting
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General instructions for WLAN RX troubleshooting

Context
To start RX troubleshooting

Steps
1. Connect the module jig MJ-148 to a computer with a DAU-9S cable or to an FPS-10 flash prommer with an

XCS-4 modular cable and USB cable. Make sure that you have a PK-1 dongle connected to the computer’s
parallel port.

2. Connect a DC power supply to the module test jig (MJ-148) with an FLC-2 cable.

Note: If CU-4 is used then correct DC supply voltage is 12V . If DC power is connected directly to
module test jig then absolutely max. DC power is 4.2 V. Use nominal value 3.7 V

3. Connect an RF cable to the RF connector of the module test jig (MJ-148) and RF signal generator;

4. Set the phone module to test jig and start Phoenix service software.

5. Initialize connection to the phone. (Use FBUS driver when using DAU-9S).

6. To choose a product in Phoenix: From the File menu, choose “Choose Product” and select RX-34 from the
list or from the File menu, choose “Scan Product”.

7. From the toolbar, set operating mode to "Local".

8. From the Testing menu, choose “WLAN RX tests”.

9. In the “WLAN RX tests” window:

• Test mode "Generator mode"

• Channel "7” (2.442 GHz)

• Press "Start" button"
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WLAN RX troubleshooting

Figure 32 WLAN RX troubleshooting
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Antenna troubleshooting
The device uses a common antenna for Bluetooth and WLAN. If fault is not found after TX and/or RX
troubleshooting then check antenna by doing SB-7 test.

If it does not work check detailed instructions for antenna troubleshooting from Bluetooth troubleshooting
in BB Troubleshooting and Manual Tuning Guide.

Introduction to WLAN RF tuning
Phone WLAN RF is tuned in production. There is no reason to do the re-calibration unlessoOne or more of the
RF components is changed.

Note:

RF calibration is always performed with the help of a product-specific module jig, never with an RF coupler.
Using an RF coupler in the calibration phase will cause a complete mistuning of the RF side.

Cable and adapter losses RF cables and adapters have some losses. They have to be taken in account when
the phone is tuned.

As all the RF losses are frequency dependent, the user have to be very careful and understand the
measurement setup. In the following table there are RF attenuations of the Rf cable CA-58 RS connected to
RF connector on PWB.:

Freq. (MHz) Attn. (dB) Tolerance (dB)

2400 0.4   0.5

2440 0.4   0.5

2480 0.4   0.5

Note: XRS-6 RF cable should be connected to SMA connector of CA-58RS cable.

Tx IQ tuning

Context
The Tx path branches to I and Q signals at the RF I/Q modulator. Modulator and analog hardware located
after the modulator cause unequal amplitude and phase disturbance to I and Q signal paths. Tx IQ tuning
balances the I and Q branches.

Steps
1. Connect the phone to a measurement equipment.

2. From the dropdown menus, set "Operating mode" to "Local"

3. From the Tuning menu, choose "WLAN Tx I/Q Tuning"

4. Set PCV value to 160 and Calibrate all channels on.

5. Click Start.
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6. Wait until automatic tuning has finished and press “Write”.

7. When the values have been written to the phone memory, click the Close button to close the tuning
window.

Tx power level tuning

Context
Because of variations in the IC process and discrete component values, the actual transmitter RF gain of each
phone is different. Tx power level tuning is used to find out mapping factors called 'power control
values’ (PCV). These factors adjust the WLAN transmitter output power to fulfill the required specifications.

Steps
1. Connect the phone to the WLAN measurement equipment.

2. From the dropdown menus, set "Operating mode" to Local.

3. From the Tuning menu, choose "WLAN Tx Tuning".

4. Adjust the measurement equipment for power level tuning. Remember to take jig and RF cable
attenuations into account!

5. Choose Data rate 6 Mbit/s. It should be 6 Mbit/s, otherwise power levels for other datarates will
be miscalculated!.

6. Click Start.
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7. Adjust all 6 power levels on every 3 (1,7 and 13) channels by adjusting PCV value to get corresponding
power (dBm). Adjusting could be made by pressing + or – keys or writing the value directly to cell.

8. After all values are adjusted to their corresponding power targets press “Finish” button.

9. Write the values to the phone memory by pressing “Write” button.

10. Finally close the window by pressing “Close”.

Note:  WLAN Tx power Level tuning is only allowed with adequate measurement equipment.

WLAN functionality testing using SB-7 WLAN test BOX with RX-44

Context
The build-up and usage of the WLAN Test Box SB-7 is described. A simple functionality test is advised. With
this test both WLAN RX/TX will be tested in weakened field scenario. The test uses active scan.

WARNING: in USA DO NOT use channels 12 and 13 for scanning.

Note:  SB-7 supports WLAN Standard IEEE 802.11b/g.

Do not open SB-7. The following just describes, what the delivery package of SB-7 consists of.

The SB-7 contains following modules:

Name of module Notes

SB-7 WLAN TEST BOX Milled aluminium

AC POWER ADAPTER 5V / 2.5A

ANTENNA D-Link, female reverse SMA
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Figure 33 SB-7 - Outside view

Figure 34 SB-7 - Inside view

Steps
1. The cover of SB-7 contains a grid starting from A1 and ending to Q17 (see figure 7). Place CU4/SS-62 +

FS-66 on SB-7 so, that the corners of SB-7 are on top of the following square of the grid: A5, A13, O4 and
O14.
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2. Antenna is pointing straight up (see figure 9). Place SB-7 on working surface so that there is at least 20cm
free space around it.

Figure 35 Placement of RX-44 on SB-7

WLAN functionality test

Context
Connect power cable and antenna to SB-7. Wait for 3 minutes to be sure that SB-7 is fully up and running.

Steps
1. Attach RX-44 with CU4/SS-62 + FS-66 and place on top of the WLAN Test Box at the correct place as explained

in WLAN functionality testing using SB-7 WLAN test BOX with RX-44.

2. Make connection to RX-44 with Phoenix (test mode).

3. Choose Testing -> WLAN Configuration.

4. Write “default” into 'Network SSID to scan' field.

5. Press Scan.
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6. If the name of the WLAN test Box (Default) appears on the list under Scan results, the RX-44 is OK (see
following figure).

After scanning signal level should be 173 +/- 6

Otherwise repeat testing 3-4 times as follows:

7. If the name was not on the list:

i Choose Power state: Off, and wait 5 seconds

ii Choose Power state: On, and wait 5 seconds

Jump to task 5.

8. If you still can’t find the name of the WLAN test Box (Default) on the list under Scan results, the RX-44 is
not OK

Note: Note: Local WLAN environment may affect test results, especially if there are many WLAN
access points nearby.

Known issue: If you manage to scan SB-7 with RX-44 and remove power from SB-7 and press scan again,
SB-7 is still found. You have to wait for 1 minute after SB-7 power down before scanning in order that
scan results history is deleted from RX-44.
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 Camera Module Specification
Thefront camera of RX-44 is for video imaging purposes only. The main use cases are video call and web
camera use. Sales release SW does not enable still imaging.

Table 13 Sub camera specification

Sensor type 1/7” CMOS sensor

Sensor valid pixels 658(H)x494(V)

F number F3.5

Focus range 30cm to infinity

Video resolution (max) 640 x 480

Video frame rate 30fps

 Camera Module Mechanics
The camera module as a component is not a repairable part, meaning that the components inside the module
may not be changed. Cleaning dust from the front face is allowed only. Use clean compressed air.

The main parts of the module are:

-1/7” CIF CMOS sensor

-24-pin board to board connector'

 Camera troubleshooting introduction

Possible Faults in Image Quality
When checking for possible errors in camera functionality, knowing what error is suspected will significantly
help the testing by narrowing down the amount of test cases.

The following types of video image quality problems may be expected to appear:

-Dust (black spots)

-Lack of sharpness

-Bit errors

In addition, there are many other kinds of possibilities for getting bad image quality, but those are ruled out
from the scope of this document since probability of their appearance is going to be minimized by production
testing.

Testing for Dust
For detecting this kind of problems, take video of uniform white surface and analyze it in full resolution.
Good quality PC CRT monitor is preferred for analysis (avoid using LCD). Search carefully since finding these
defects is not always easy.

Figure below gives an example of still image containing easily detectable dust problems. For taking a white
video uniformly lightened white paper or white wall can be used. One possibility is to use uniform light but
make sure that camera image is not flickering when taking test ivideo.

In case flickering happens try to reduce illumination level. Black spots in image are caused by dirt particles
trapped inside the optical system. Clearly visible and sharp edged black dots in image are typically dust
particles on image sensor. These spots are searched for in manufacturing phase, but it is possible that the

RX-44
Camera troubleshooting

Issue 1 COMPANY CONFIDENTIAL Page 6 –5
Copyright © 2007 Nokia. All rights reserved.



camera body cavity contains a particle, which may move onto the image sensor active surface, e.g. when the
phone is dropped. Thus it is also possible that the problem will disappear before the phone is brought to
service.

The camera should be replaced if the problem is present when the service technician analyses the phone. If
dust particle is lying on infrared filter surface on either side, they are much harder to locate because they
will be out of focus, and appear in image as large, grayish and fading-edge 'blobs'.

Sometimes they will be very hard to find, and thus the user probably will not notice them at all since they
do no harm. But it is possible that a larger particle disturbs the user, causing need for service.

If large dust particles get trapped on top of the lens surface in the cavity between camera window and lens,
they will cause image blurring and poor contrast (see also item 'sharpness').

The dust gasket between the window and lens should prevent any particles from getting into the cavity after
manufacturing phase. If dust particles are found on sensor, this is classified as a manufacturing error of the
module and thus the camera should be replaced, since camera module cannot be dissembled without
damaging it.

Any particles inside the cavity between protection window and lens have most probably been trapped there
in assembly phase at camera module supplier. Unauthorized disassembling of product can also be root cause
for the problem.

Testing for Sharpness

Effects of Dirty or Defective Protection Window
If video image taken with some device are claimed to be blurry, there are following possible sources for the
claim:

1 Protection window is fingerprinted, soiled, dirty, visibly scratched or broken.
2 Camera module has failed to focus correctly. Producing a blurred image.
3 User has tried to take video in too dark conditions and video is blurred due to handshake or movement.

This is no cause to replace camera module.
4 There is dirt between protection window and camera lens.
5 The protection window is defective. This can be either manufacturing failure or caused by user. Camera

module should be changed.

It should be noted that the effects of any dirt in video images can vary very much; it may be difficult to judge
if the window has been dirty when some image has been taken or if something else has been wrong.
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That is why the cleanness of the protection window should always be checked and the window should be
wiped clean with a suitable cloth.

Bit Errors
Bit errors are defects in image caused by data transmission error between camera and phone baseband or
inside camera module. Bit errors can be typically seen in images taken of any object, and they should be most
visible in full resolution video images.

A good practice is to use uniform white test target when analyzing this kind of errors. The errors will be
clearly visible as colorful sharp dots or lines in camera images. See figure below.

One type of bit error is lack of bit depth. In that case image is almost totally black under normal conditions
sensing something only under very high illumination. Typically this is a contact problem between the camera
module and phone main PWB. Check camera assembly and connector contacts. If fault is in the camera module
typically bit error is visible only when using some specific video resolution.
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 Camera viewfinder troubleshooting

Troubleshooting flow
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 Camera bad image quality troubleshooting

Troubleshooting flow
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 Camera BB HW troubleshooting

Troubleshooting flow
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 Baseband description

System module block diagram
The device consists of four different main modules: engine (2 EH), Main flex (2FC), Top Flex (2FD) , camera
and LCD module. The engine module consists of BB and RF components. Connection between UI flexies,,
camera and display is done with board-to-board connectors.

Figure 36 RX-44 system block diagram

Baseband functional description
The device is based on OMAP2420 (D4800) application processor on top of which the SDRAM / MuxOneNAND
combo memory is stacked. More detailed information about OMAP2420 (D4800) is presented in the following
chapter. EM asics are EM ASIC Vilma D1420, EM ASIC Betty N1310 and EM ASIC Menelaus N4200. Keyboard and
its lightning are controlled by N4300, AIC33 audio codec is N4100 and touch pad controller N1530. HS-USB
interface goes via USB controller ASIC N5350 and USB EM ASIC N5350. WVGA display has external display frame
buffer D1510.

Application processor
The application processor OMAP2420 (D4800) is also called an application ASIC because it is processing
application SW and handles the UI SW. It consists of the application processor and peripheral subsystems
such as camera, display and keyboard driver blocks.

In addition to interfaces mentioned above, the peripherals block includes several different I/O interfaces, for
example, for keyboard, audio, Bluetooth and WLAN.
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Absolute maximum ratings

Signal Min Nom Max Uni
t Notes

Battery voltage (idle) -0.3 +4.5 V Battery voltage maximum value is
specified during charging is active

Battery voltage (Call) +3.2 +4.3 V Battery voltage maximum value is
specified during charging is active

Charger input voltage -0.3 +20 V

Back-Up supply voltage 0 2.5 2.6 V Maximum capacity of the backup
power supply assumed to be 16 µAh.

Device modes of operation

Mode Description

NO_SUPPLY (dead) mode means that the main battery is not present or its voltage is too low (below
EM ASIC D1420 master reset threshold) and that the back-up battery voltage is too low.

BACK_UP The main battery is not present or its voltage is too low but back-up battery voltage is
adequate and the 32kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over EM ASIC D1420
master reset threshold.

RESET RESET mode is a synonym for start-up sequence.

SLEEP SLEEP mode is entered only from PWR_ON mode with the aid of SW when the system’s
activity is low.

FLASHING FLASHING mode is for SW downloading.

Voltage limits

Parameter Description Value

VMSTR Master reset threshold (D1420) 2.2V (typ.)

VMSTR+ Threshold for charging, rising (N1310) 2.1V (typ.)

VMSTR- Threshold for charging, falling (N1310) 1.9V (typ.)

VCOFF+ Hardware cutoff (rising) 2.9V (typ.)

VCOFF- Hardware cutoff (falling) 2.6V (typ.)

SWCOFF SW cutoff limit ~3.2V

The master reset threshold controls the internal reset of EM ASICs. If battery voltage is above VMSTR, N1310
charging control logic is alive. Also, RTC is active and supplied from the main battery. Above VMSTR, N1310
allows the system to be powered on although this may not succeed due to voltage drops during start up. SW
can also consider battery voltage too low for operation and power down the system.
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Power key
The system boots up when power key is pressed (adequate battery voltage, VBAT, present).

Power down can be initiated by pressing the power key again (the system is powered down with the aid of
SW).

Power distribution
Generally, RX-44 EM architecture is implemented with three EM ASICs, EM ASIC Vilma D1420, EM ASIC Betty
N1310 and EM ASIC Menelaus N4200 controlling the EM and supplying the output voltages.

In addition to the ASICs, N5351 PM ASIC handles the power supply for HS USB controller.

In addition to mentioned EM ASICs, RX-44 EM includes functionalities to be powered using discrete regulator
or direct battery voltage supply.

The following functionality is supplied with discrete power supplies:

• LCD analog Supply (2.8V)

• System clock oscillator

• eMMC core (3.0V) and IO (1.8V)
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Figure 37 RX-44 power distribution

Clocking scheme and controlling signals
There are two main clocks in the BB system: 19.2 MHz square wave clock provided by discrete oscillator and
32.678 kHz sleep clock produced by the EM ASIC D1420 with an external crystal.

RX-44
System Module

Page 7 –8 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



Interfaces

Bluetooth
Bluetooth data interface is connected to UART1 of application processor D4800. UART is an asynchronous
interface for transferring data and control information to BT device.

WLAN
WLAN host interface is 4-line synchronous serial interface.

HS-USB
Universal Serial Bus is a galvanic interconnection between product and an external device. RX-44 is High
Speed USB 2.0 OTG device, through the Micro-AB connector.

OTG (On-To-Go) support means that RX-44 can work as host (like PC) in USB connection to another USB slave
device. Supported (e.g. another RX-44) slave devices are shown as mass storage device connection in RX-44
file manager.

Memorycards
The device hasone memory card reader, which support dual voltage cards. In addition, there is an internal
memory card assembled on PWB.

Internal 2GB eMMC flash memory is intended for user content storage. It can be used to store pictures, music,
map files etc. This memory is shown in file manager as internal memory card and is not removable by the
user.

The external memory card is supplied with dual 1.8/3 V supply voltage, depending on the card type.

The detection of external memory card removal/insertion is done by a switch in the lid. Internal memory
card is assembled on PWB and is not removable by the user.
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Battery interface
The battery interface supports BP-4L battery. This interface consists of three connectors: VBAT, BSI and GND.
BSI line is used to recognize battery capacity by a battery internal pull down resistor.

Battery temperature is estimated by measuring separate battery temperature NTC via BTEMP line, which is
located on the transceiver PWB, in a place where phone temperature is most stabile.

For service purposes the device SW can be forced into local mode by using pull down resistors connected to
the BSI line.

User interface

Main display

Display module features:
The device has one display.

Video interface is used for image data transfer (video and still) and serial interface is used for sending
commands.

• 800x480 transmissive LTPS LCD display

• 65k colours used in RX-44

• a backlight incorporating 6 white LED’s to illuminate the display.

• a touch screen

• Compact Display Port (CDP) for display data and serial interface (LOSSI) for commands.

The display has four different operating modes:

• Normal mode

• Sleep mode

• Partial mode

• Off

The interconnection between the LCD module and the main flex assembly is implemented with a 30-pin
board-to-board connector. Display is controlled via LCD controller using LOSSI interface (Low Speed Serial
Interface).

Image data is transferred through 3-link CDP (Compact Display Port). CDP is using differential sub-LVDS voltage
levels.

The display module does not require any tunings. Display backlights are powered with discrete SMPS.

Figure 38 800x480 transmissive LCD display
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HW keys

Upper block
The upper block HW keys (Home, Back) are located in main flex, which is connected to the main PWB with a
64-pin board-to-board connector.

Lower block
Top left corner of the device has 5 HW keys, full screen, volume up, volume down, power and device lock key.
These keys are connected to engine PWB through topflex assembly 10-pin board-to-board connector.

Engine pwb implements full Qwerty keyboard, 5-way rocker and Menu key.

All the keys (except power and lock key) are on matrix. The key matrix has eight rows and twelve columns,
which is connected to the LM8323 integrated keyboard controller.

Power button is connected directly to AVilma and Lock key is connected directly OMAP2420POP GPIO102.

Table 14 Main flex keys

Ref Name Pin No.

S1000 Home 54

S1001 Back 55

V1001 RGB led 50, 51, 53

N1000 ALS See schematics

X1002 Camera connector See schematics

X1001 Display Connector See schematics

X1003 Main Flex connector See schematics
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Figure 39 Main flex layout

UI illumination
Display backlight power supply is implemented with Betty’s current regulated step-up converter. The most
important edge conditions are sufficient high output power and efficiency of the converter. Dimming of
backlights is implemented with traditional PWM control.

Qwerty keyboard and Rocker button backlights are supplied by two TPS75105 converters that are controlled
by PWM signal fed from Keyboard controller. Keypad illumination conditions are controlled by OMAP2420POP
according the device state and ambient light conditions.

Keypad controller communicates with OMAP2420POP through GEN_I2C bus. RGB LED which is placed in top
left corner of the device is used to indicate the status of the device mainly when the display has been turned
off.

The on / off control for indication LED is implemented using integrated RGB LED driver LP5521. RGB controller
communicates with OMAP2420POP through GEN_I2C bus.
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Figure 40 RX-44 UI illumination

RGB indication
Red Green Blue (RGB) LED, which is placed on main flex is used to indicate the status of the device mainly
when the display has been turned off.

ALS
• The TSL2563 is low-voltage (2.5V) light-to-digital converter that transform light intensity to a digital signal

I2C interface. Device combines one broadband photodiode (visible plus infrared) and one infrared-
responding photodiode. Two integrating ADCs convert the photodiode currents to a I2C bus that represents
the irradiance measured on each channel.

• Display and keypad backlight intensity are controlled according to ALS output.

Top flex pinout

Table 15

Key Name Pin No.

S1000 Power 10

S1001 Volume+ 8

S1002 Volume- 7

S1003 Zoom 6

S1004 Lock 9

Table 16

Lock Switch
Position

Open Closed (pressed)

Switch contact Open Closed

GPIO102 VCC GND

RX-44
System Module

Issue 1 COMPANY CONFIDENTIAL Page 7 –13
Copyright © 2007 Nokia. All rights reserved.



Figure 41 Top flex assembly

Camera
The device has a camera module, which includes area color image sensor embedded with camera signal
processor that meets with VGA format.

In the sensor area 494 vertical and 658 horizontal signal pixels, and the image size meets with 1/7-inch
optical format.

Camera is intended for video imaging purposes.

Figure 42 Camera architecture

ASICs

Application processor OMAP2420 D4800
OMAP is the application processor running with OSSO 1.1 Linux based open source software operating system.

It is the platform for executing all user related application.

Key functions:

• Camera interface

• Display interface (via Hailstorm D1510 display buffer)

RX-44
System Module

Page 7 –14 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



• Bluetooth data interface

• WLAN data interface

• SD interface (via Menelaus)

• USB interface (Via TUSB6010 USB transceiver to OMAP2420 NOR flash interface)

• I2C interface for temperature sensor, Keypad IO expander, ALS, RGB led controller

Power supply:

• Core voltage VCORE_APE=1.4V (in local mode) generated by Menelaus

• VCORE_APE is lowered to 1.05V in sleep mode

• I/O voltage VIO_APE=1.8V generated by Menelaus

Clock frequencies:

• SysClk=19.2 MHz as main clock provided by external oscillator G4850

• SleepClk=32.768 kHz as sleep clock provided by Vilma

EM ASIC Menelaus N4200
Menelaus is an auxillary energy management ASIC.

It acts in addition to AVilma and Betty.

Key functions:

• OMAP2420 Core supply generation

• OMAP2420 I/O supply generation

• OMAP2420 PLL block supply generation

• DDR/NAND Memory Core and I/O supply generation

• Camera modulue supply generation

• Level shifter and regulator for miniSD card

• Level shifter for internal eMMC

EM ASIC Vilma D1420
EM ASIC Vilma includes following functional blocks:

• Start up logic and reset control

• Charger detection

• Battery voltage monitoring

• 32.768kHz clock supply with external crystal

• Real time clock with external backup battery

• SIM card interface (Not used in RX-44)

• Stereo audio codecs and amplifiers (Not used in RX-44)

• A/D converter

• Regulators

• Vibra interface (Not used in RX-44)

• Digital interface (CBUS)

EM ASIC Betty N1310
EM ASIC Betty includes following functional blocks:

• Core Voltage supply generation for Hailstorm Display buffer D1510

RX-44
System Module

Issue 1 COMPANY CONFIDENTIAL Page 7 –15
Copyright © 2007 Nokia. All rights reserved.



• Charge control circuitry

• Level shifter and regulator for USB/FBUS (Not used in RX-44)

• Current gauge for battery current measuring

• Integrated LED driver (Not used in RX-44)

• External LED driver control interface for Display backlight

• Digital interface (CBUS)

ASICS N5350 and N5351
ASIC N5350 (TUSB6010) is a physical layer of USB OTG transceiver IC including crystal oscillator, PLL, USB
controller (core), OMAP 2420 interface logic.

ASIC N5351 (TPS65030): a dedicated Power Management ASIC for USB OTG transceiver.

Device memories

Memory package
Package-On-Package (POP) memories refer to memories that are in separate package, and attached on top
of the processor.

APE memory (POP3)
RX-44’s APE memory POP3 consists of DDR/MuxOneNAND combo memory.

DDR memory is using 32-bit interface and flash memory is using 16-bit muxed NOR interface.

• 1Gbit DDR + 2Gb MuxOneNAND

This capacity memories consist of three dies stacked on top of each other.

 Audio concept

Audio concept
The device provides acoustical stereo audio output via integrated dynamic speakers and electrical calvanic
stereo audio output via 3.5mm Nokia AV interface. Analog audio signal capture is handled by internal digital
microphone and via Nokia AV interface using headset’s microphone, such as Nokia HS-48.
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Figure 43 Audio concept

The D4800 is the heart of the device's audio system handling digital signal processing and controlling of
audio related peripherals chips.

The audio HW codec handling ADC and DAC tasks and analog signal amplifications is referred as N4100. The
N4100 is also interface against the device’s internal digital microphone module B4130.

Internal speakers
The D4800 feeds digital audio data to the N4100 via the I2S interface. After the N4100 the signal is further
amplified by stereo audio power amplifier (N4101) and fed to the dynamic speakers (B4140 and B4141).
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Figure 44 Internal speakers

Internal microphone
The digital microphone module is connected directly to the interface provided by the N4100. The microphone
is also powered by the microphone bias generator of the N4100 by 2.0Vdc. After filtering and decimation the
signal is passed to the D4800 for futher usage via the I2S bus.

Figure 45 Internal microphone
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Nokia AV connector
A 3.5mm round 4-pole SMD connector is used for stereo audio out, mono audio in (external microphone) and
enhancement identification purposes.

All signals are single-ended type and enhancement identification is implemented throught the same pin that
external mic also uses.

Figure 46 Nokia AV connector

Table 17 Pin/signal orders

3.5mm Pin
#

Signal name Direction Description

6 PLUGDET Input Terminal internal connection, plug
detection

5 HS EAR L Output Audio output

4 HS EAR R Output Audio output

3 HS MIC Input Microphone audio & send/end button
info

1, 2 HS GND - Ground contacts

Nokia AV interface, output
The D4800 feeds digital audio data to the N4100 via the I2S interface. After the N4100 the signal is further
amplified by stereo audio power amplifier (N4102) and fed to the 3.5mm Nokia AV interface connector
(X4100).
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Figure 47 Nokia AV interface, output

Nokia AV interface, input
Traditional analog electret type of microphone is supported by the Nokia AV interface.

The microphone is biased by the 2.1Vdc from the D1420 asic. The weak analog audio signal got from the
microphone is fed to the N4100, amplified, AD converted and passed to the D400 for further usage via the
I2S interface.
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Figure 48 Nokia AV interface, input

 Sensors and switches

Slide position switch
Slide position switch, a hall sensor is used for detecting if slide is open or closed position.

Hall sensor is located in main PWB and magnet is located in the slider assembly. Sensor output is to
OMAP2420POP GPIO110. Sensor signal is used by UI software to select suitable features according the device
state.

Slide Position Open Closed

Switch contact Open Closed

GPIO110 VCC GND

SD door switch
A mechanical switch is used for SD door opening detection.

Switch is connected to card detect pin of N4200.

Door Position Open Closed

Switch contact Closed Open

Detect pin GND VCC
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 Baseband technical specifications

External interfaces

External interfaces

Table 18 External interfaces

Name of connection Connector reference

Battery X1110

Charger X1100

USB X5300

External memory card reader X5201

Main Flex X4700

Audio jack X4100

Display (on main flex) X1001

Camera (on main flex) X1002

Top Flex X4300

Battery connector

Figure 49 Battery connector pinout

Table 19 Battery connection

Pin Signal Notes

1 VBAT Battery voltage

2 GND Battery Status indication (fixed resistor
inside the battery pack)

3 BSI Ground
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Charger Interface

Table 20 Charging connector

Pin No Pin Name Description Voltage levels,
current

Comment

1 CHARGE Charger input 0-9V, 0.85A Center pin

2 GND Ground 0.85A

Internal interfaces

LCD interface
X1001 in main flex connected to display frame buffer.

No. Name I/O Function

1 TP Output Touch panel analog signal

2 TP Output Touch panel analog signal

3 GND Ground Ground

4 D2+ Input Data bus

5 D2- Input Data bus

6 GND Ground Ground

7 D1+ Input Data bus

8 D1- Input Data bus

9 GND Ground Ground

10 Clk+ Input CDP Clock Positive

11 Clk- Input CDP Clock Negative

12 GND Ground Ground

13 D0+ Input Data bus

14 D0- Input Data bus

15 GND Ground Ground

16 VDD Supply Logic supply (1.8V)

17 VDDI Supply Analog supply (2.8V)

18 SCL Input Serial clock

19 DOUT Output Serial data out

20 DIN Input Serial data in

21 CSX Input Chip select

22 RESX Input Reset

23 GND Ground Ground

24 LED2+ LED LED current source 2
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No. Name I/O Function

25 LED1- LED LED current sink 1

26 LED1+ LED LED current source 1

27 LED2- LED LED current sink 2

28 GND Ground Ground

29 TP Output Touch panel analog signal

30 TP Output Touch panel analog signal

Camera interface

Table 21 Pin functions

No. NAME I/O FUNCTION

1 EXTCLK I Clock for external input

2 VDD25 - Power supply (2.8V or 2.5V)

3 D5(DOUT5) O Data output

4 D1(DOUT1) O Data output

5 D2(DOUT2) O Data output

6 D0(DOUT0) O Data output (LSB)

7 D3(DOUT3) O Data output

8 D6(DOUT6) O Data output

9 D7(DOUT7) O Data output (MSB)

10 D4(DOUT4) O Data output

11 VDD15 - Power supply (1.5V)

12 DCLK O Clock for output data

13 GND - GND (IOVSS)

14 GND - GND (IOVSS)

15 GND - GND (IOVSS)

16 IOVDD - Power supply for I/O (1.8V)

17 VD O Vertical synchronization pulse output

18 HD O Horizontal synchronization pulse
output

19 SDA I/O Data for I2C-bus command

20 RESET I RESET terminal ("L" active)

21 SCL I Clock for I2C-bus command

22 GND - GND (IOVSS)

23 GND - GND (IOVSS)

24 GND - GND (IOVSS)
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Topflex connector X4300

No. Name I/O Function

1 GND Ground Ground

2 GND Ground Ground

3 GND Ground Ground

4 GND Ground Ground

5 GND Ground Ground

6 Zoom Output Zoom Key

7 Volume down Output Volume up key

8 Volume up Output Volume down key

9 Lock Output Lock Switch (1V8)

10 PWRONX Output Power button (VBAT)

 RF description

WLAN RF description

Transceiver
Wlan RF implements 802.11b/g WLAN radio for embedded, low-power and small form factor mobile
applications. It conforms to the IEEE 802.11b/g protocols operating in 2.4 GHz band supporting OFDM data
rates of 54, 48, 36, 24, 18, 12, 9, and 6 Mbps as well as CCK data rates of 11 and 5.5 Mbps and legacy data
rates of 2 and 1 Mbps. IEEE802.11e/i protocol extensions are included to implement quality of service (QoS)
and security functions.

Parameter Value

Frequency range 2412-2472MHz

Channel spacing 5 MHz

Number of channels 11 in US

13 in EU

13 in France

Frequency accuracy -+25 ppm
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Parameter Value

Data rates and modulations IEEE802.11b:

1 Mb/s BPSK, Barker spreading

2 Mb/s QPSK, Barker spreading

5.5 and 11 Mb/s QPSK, CCK coding

IEEE802.11g:

6 and 9 Mb/s BPSK

12 and 18 Mb/s QPSK

24 and 36 Mb/s 16QAM

48 and 54 Mb/s 64QAM

The RF block diagram is shown below:

Figure 50 WLAN RF block diagram

STLC4560 implements 802.11b/g WLAN radio for embedded, low power and small form factor mobile
applications.

STLC4560 is a three-die multichip module. The system implementation is partitioned to radio, baseband and
energy management dies.

STLC4560 has a fully integrated radio chip including a direct-conversion transceiver, RF synthesizer and VCO,
and high-speed data converters.

The baseband includes required logic and interfaces to enable simultaneous use of BT and WLAN.

The energy management chip integrates required power management functions to operate the system from
VBAT (3.0 – 5.5 V). In default configuration the chip has SMPS to generate 1.2 V digital core voltage, two 1.8
V LDOs for RF and 2.8 V LDO for PA bias supply.
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The EM chip also integrates power-on reset circuitry and level-shifters for RF front-end GaAs switches.

Host interface is provided by a flexible serial interface (SPI) supporting clock frequency upto 60 MHz. The
system uses 19.2 or 38.4 MHz reference clock from the cellular system as the reference.

RF5924 Front-End Module (FEM) implements amplification of the transmit signal to required power levels.
FEM is connected to VBAT and it has integrated b/g power amplifier, power detector, RX balun, and TX filtering.

Also, it is capable of switching between WLAN RX, WLAN TX and BTH RX/TX operations. .

Synthesizer
The PLL synthesizer with VCO is integrated into RFIC, only the loop filter is needed outside the RFIC.

Antenna
WLAN/BTH has a common antenna and is located in decoration cover. Antenna is shown in picture 23.

WLAN TX description

Transmitter characteristics
The transmitter consists of:

• final frequency IQ-modulators

• power amplifier, for the lower and upper bands separately

• power control loop.

The IQ-modulator is integrated in STLC4560, as well as the operational amplifiers of the power control loop.
The power amplifier is located in a single module with a power detector.

Item Values

Type Direct conversion

LO frequency range 4824...4944 MHz

Output power 802.11b:

17 dBm

802.11g:

13/15/ dBm

Gain control range 60 dB

GPS interface
The device includes an inbuilt GPS receiver and it works as a stand-alone positioning device. The antenna is
located on the top left corner of the product.

The GPS system is connected to OMAP2420 ASIC.
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Figure 51 Block diagram of the GPS system
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A/D-converter Analog-to-digital converter

ACI Accessory Control Interface

ADC Analog-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic ,type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2,UEME and Zocus

CCP Compact Camera Port

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSR cambridge silicon radio

CSTN Color Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analouge converter

DAC Digital-to-analouge converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo

DCT-4 Digital Core Technology

DMA Direct memory access

DP Data Package
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DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evaluation

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compability

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GMSK Gaussian Minimum Shift Keying

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity

IR Infrared

IrDA Infrared Data Associasion

ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out
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LED Light-emitting diode

LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architechture

OMAP Operations, maintenance, and administartion part

Opamp Operational Amplifier

PA Power amplifier

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x and BB5

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board

PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RF Radio Frequency

RF PopPort TM Reduced function PopPortTM interface

RFBUS Serial control Bus For RF

RSK Right Soft Key

RS-MMC Reduced size Multi Media Card

RSS Web content Syndication Format

RSSI Receiving signal strength indicator

RST Reset Switch
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RTC Real Time Clock (provides date and time)

RX Radio Receiver

SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noice ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC

USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator

VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator

Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WD Watchdog

XHTML Extensible hypertext markup language

Zocus Current sensor, (used to monitor the current flow to and from the battery)
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